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Preface

Welcome to the Oracle Balanced Scorecard Install Guide, Release 11i.

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ Oracle Balanced Scorecard.

If you have never used Oracle Balanced Scorecard, Oracle suggests you attend 
one or more of the Oracle Applications training classes available through Oracle 
University.

■ The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.
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How To Use This Guide
The Oracle Balanced Scorecard Install Guide contains the information you need to 
understand and use Oracle Balanced Scorecard. This guide contains the following 
chapters:

■ Chapter 1, "Introduction"

■ Chapter 2, "Installing Balanced Scorecard"

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program Web site at http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation
JAWS, a Windows screen reader, may not always correctly read the code examples 
in this document. The conventions for writing code require that closing braces 
should appear on an otherwise empty line; however, JAWS may not always read a 
line of text that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation 
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor 
makes any representations regarding the accessibility of these Web sites. 
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Other Information Sources
You can choose from many sources of information, including documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle Balanced Scorecard.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). 

■ PDF Documentation- See the Online Documentation CD for current PDF 
documentation for your product with each release. This Documentation CD is 
also available on OracleMetaLink and is updated frequently. 

■ Online Help - You can refer to Oracle Applications Help for current HTML 
online help for your product. Oracle provides patchable online help, which you 
can apply to your system for updated implementation and end user 
documentation. No system downtime is required to apply online help.

■ Release Content Document - See the Release Content Document for 
descriptions of new features available by release. The Release Content 
Document is available on OracleMetaLink. 

■ About document - Refer to the About document for information about your 
release, including feature updates, installation information, and new 
documentation or documentation patches that you can download. The About 
document is available on OracleMetaLink. 

Related Guides
Oracle Balanced Scorecard shares business and setup information with other Oracle 
Applications products. Therefore, you may want to refer to other guides when you 
set up and use Oracle Balanced Scorecard.

You can read the guides online by choosing Library from the expandable menu on 
your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.
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Guides Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI). This guide also includes information on setting user 
profiles, as well as running and reviewing reports and concurrent processes.

You can access this user’s guide online by choosing “Getting Started with Oracle 
Applications” from any Oracle Applications help file.
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Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications 
and the Oracle technology stack by automating many of the required steps. This 
guide contains instructions for using Oracle Rapid Install and lists the tasks you 
need to perform to finish your installation. You should use this guide in conjunction 
with individual product user guides and implementation guides.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 
10.7 (NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 
11i. You cannot upgrade to Release 11i directly from releases prior to 10.7.

“About” Document
For information about implementation and user documentation, instructions for 
applying patches, new and changed setup steps, and descriptions of software 
updates, refer to the ”About” document for your product. ”About” documents are 
available on OracleMetaLink for most products starting with Release 11.5.8.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.
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Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff and describes the Oracle Application Object Library components 
that are needed to implement the Oracle Applications user interface described in 
the Oracle Applications User Interface Standards for Forms-Based Products. This manual 
also provides information to help you build your custom Oracle Forms Developer 
forms so that the forms integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Other Implementation Documentation

Oracle Applications Product Update Notes
Use this guide as a reference for upgrading an installation of Oracle Applications. It 
provides a history of the changes to individual Oracle Applications products 
between Release 11.0 and Release 11i. It includes new features, enhancements, and 
changes made to database objects, profile options, and seed data for this interval.

Oracle Workflow Administrator's Guide
This guide explains how to complete the setup steps necessary for any Oracle 
Applications product that includes workflow-enabled processes, as well as how to 
monitor the progress of runtime workflow processes.
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Oracle Workflow Developer's Guide
This guide explains how to define new workflow business processes and customize 
existing Oracle Applications-embedded workflow processes. It also describes how 
to define and customize business events and event subscriptions.

Oracle Workflow User's Guide
This guide describes how Oracle Applications users can view and respond to 
workflow notifications and monitor the progress of their workflow processes.

Oracle Workflow API Reference
This guide describes the APIs provided for developers and administrators to access 
Oracle Workflow.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle Balanced Scorecard implementation team, as well as for users responsible for 
the ongoing maintenance of Oracle Applications product data. This guide also 
provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on OracleMetalink.

Oracle Applications Message Manual
This manual describes all Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.
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Training and Support

Training
Oracle offers a complete set of training courses to help you and your staff master 
Oracle Balanced Scorecard and reach full productivity quickly. These courses are 
organized into functional learning paths, so you take only those courses 
appropriate to your job or area of responsibility.

You have a choice of educational environments. You can attend courses offered by 
Oracle University at any one of our many education centers, you can arrange for 
our trainers to teach at your facility, or you can use Oracle Learning Network 
(OLN), Oracle University's online education utility. In addition, Oracle training 
professionals can tailor standard courses or develop custom courses to meet your 
needs. For example, you may want to use your organization structure, terminology, 
and data as examples in a customized training session delivered at your own 
facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Balanced Scorecard 
working for you. This team includes your technical representative, account 
manager, and Oracle’s large staff of consultants and support specialists with 
expertise in your business area, managing an Oracle server, and your hardware and 
software environment.
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Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle develops and markets an integrated line of software products for database 
management, applications development, decision support, and office automation, 
as well as Oracle Applications, an integrated suite of more than 160 software 
modules for financial management, supply chain management, manufacturing, 
project systems, human resources and customer relationship management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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Your Feedback
Thank you for using Oracle Balanced Scorecard and this user guide.

Oracle values your comments and feedback. In this guide is a reader’s comment 
form that you can use to explain what you like or dislike about Oracle Balanced 
Scorecard or this user guide. Mail your comments to the following address or call 
us directly at (650) 506-7000. 

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA  94065
U.S.A.

Or, send electronic mail to appsdoc_us@oracle.com.
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1
Introduction

This chapter provides an overview of the architecture of the Oracle Balanced 
Scorecard (BSC). This includes an overview of the basic usage, architecture options 
and system requirements for BSC.

This chapter contains the following sections:

■ Overview on page 1-1

■ System Architecture on page 1-1

■ System Requirements on page 1-4

Overview
Oracle Balanced Scorecard (BSC) is part of the Oracle Business Intelligence set of 
applications.  This application turns performance management systems into active 
management tools by enabling their deployment across an organization, using 
powerful, web-enabled graphical interfaces.  The BSC links strategy to management 
action by placing the organization’s key performance indicators and data right on 
managers’ desktops, giving them quantifiable targets to achieve, aligned with the 
organization’s strategy.  Also, by illustrating the cause-and-effect relationships 
between key performance indicators, the Oracle Balanced Scorecard provides 
managers with a clear understanding of how their decisions impact not only their 
direct area of responsibility, but also other departments, and the overall company 
strategy.

System Architecture
This section describes the system architecture of the BSC Viewer and the BSC 
Architecture modules.
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Three Tier Architecture for BSC Viewer
Oracle Balanced Scorecard uses 3-tier architecture which is comprised of a database 
tier, a web server tier, and a desktop tier. Users connect to Balanced Scorecard 
through any java enabled web browser. The web server tier provides business logic 
and generates dynamic web pages. The presentation layer of the web server, which 
is part of the application tier, and the business logic for Balanced Scorecard are 
implemented as Java Servlets and JavaServer Pages (JSP) running on Apache JServ. 
Apache JServ, a module of Apache Web Server, implements the Java Servlet API for 
running server side Java. 

Figure 0–1 Three Tier Architecture for BSC Viewer

Balanced Scorecard  shares the common Oracle Self-Service Web Applications 
signon to provide a common gateway to all Self-Service Applications. When you 
first access Balanced Scorecard, you will see the Oracle Self-Service Web 
Applications home page. Enter your user name and password for authentication to 
begin your session. You will then be redirected to the Apache Web Server to begin 
Balanced Scorecard activity.

Desktop
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Application Tier
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HTTP server
(Apache HTTP

Server)
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Browser

PL/SQL
cartiridge

Data server
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Architecture for BSC Architecture Modules
BSC Architecture modules are installed in client-server mode connected to an 
enterprise database.

The BSC Architecture modules include:

■ BSC Setup: This is the tool used to set up the BSC system after installation. It is 
used to register BSC systems, administer database privileges, import data, 
upgrade systems from previous Releases, and migrate data between systems.

■ BSC Architect: This tool is used to set up balanced scorecards; create and 
configure indicators, groups and datasets; and set calculation and other options 
inside BSC tables where data is stored. There are three sub-modules:

Builder: Used to create indicators and groups, and to assign KPIs to different 
balanced scorecards.

KPI Designer: Used to arrange how KPIs are viewed and categorized; configure 
the functionality of scorecard formulas and datasets; and generally tailor the 
design of the balanced scorecard for the user.

Metadata Optimizer: Used to evaluate all the datasets and dimensions specified 
for a balanced scorecard KPI, and then create an input table structure for 
populating data to the balanced scorecard. This is run after changes are made in 
KPI Designer that affect the configuration of different indicators and groups.

■ BSC Manager: This tool is used to load and configure the data in the BSC 
tables. There are two sub-modules:

Loader: Used to physically load data into the tables used by the Viewer from the 
input tables.

Administrator: Used to assign and restrict access to balanced scorecards (tabs) 
and KPIs according to responsibility title.

■ BI Builder:  The Oracle Business Intelligence Builder (Oracle BI Builder) is a 
powerful HTML design tool allowing the configuration of performance 
management systems with the flexibility of the BSC design model.  The Oracle 
BI Builder is the first phase of a complete HTML design tool.  In this release, 
and for preseeded measures, the tool already includes most of the functionality 
BSC designers have in the BSC Builder tool (one of the module of the BSC 
Architect).  Future releases will progressively increase the functionality of this 
tool until it completely replaces the BSC Architect.
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System Requirements
This section outlines the system requirements for Oracle Balanced Scorecard, 
including requirements for the web browser, software, and BSC Architect platform.

BSC Architect Platform Requirements
■ Pentium CPU, or equivalent, with a minimum processor speed of 266 MHz.

■ Windows NT Version 4.0 and Service Pack 3.

■ Minimum Disk Space of 65 MB. 

■ Minimum recommended memory of 64 MB.

■ BSC Architect requires Oracle 8.0.6 Client and Microsoft Excel 95 or above.

■ Windows XP users must install the Oracle 9i Release 2 client in addition to the 
Oracle 8.0.6 client.
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2
Installing Balanced Scorecard

BSC Architect Modules Installation
This section covers the steps for installing the BSC Architect modules and some minimum 
deployment steps. The Balanced Scorecard Architect modules are: BSC setup, BSC 
Architect, and BSC Manager. 

Prerequisites

Step 1  Deinstall previous releases of BSC Architect Modules
If you have previously installed Balanced Scorecard, deinstall those versions. Use the Oracle 
Installer that you originally used to install the previous releases of BSC Architect (for 
example, the version in the directory c:\Oracle for Windows NT\Oracle Installer).  

Before you deinstall previous versions of Balanced Scorecard, we recommend that you back 
up your Balanced Scorecard system(s).   Use Export with the Setup Wizard, then save the 
resulting .dmp file in a directory that is different than your Oracle Home.

Step 2  Shut down Oracle applications, services, and browser
Shut down any Oracle applications and services.  Go to Start > Settings > Control Panel > 
Services.  In the Services window, choose each Oracle service individually, choose HW 
Profiles, and disable the service.  To ensure no services are running, open the Windows NT 
Task Manager (CTRL-ALT-DEL).  On the Processes tab, select any Oracle services, then 
choose End Process.  Close any open applications, including your Web browser.

Step 3  Confirm administrative rights and disk space
You will need Windows NT administrative rights to register your Balanced Scorecard 
system.  To confirm if you have administrative rights, choose Start Menu > Programs > 
Administrative Tools > User Manager.  Under the User menu, if the option New User is not 
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available, you do not have administrative rights.  You must ask your system administrator to 
grant administrative rights to your NT user ID or create a new user ID that does have 
administrative rights. 

To install BSC Architect and Oracle 8.0.6 Utilities you need 65 MB of space. If your drive is 
partitioned, you need 30 MB on drive c:/, since the installation procedure may use 
Temporary folders in C while BSC Architect is being installed.  To check your available 
disk space, choose Start > Programs > Windows NT Explorer.  Choose the node for the 
drive where you plan to install BSC Architect, then choose File > Properties.

Installing BSC Architect Modules
Installing the BSC Architect module involves these steps:

1. Install Oracle 8.0.6 Utilities on page 2-2

2. Install Oracle 9i Release 2 (Windows XP Users Only) on page 2-6

3. Install BSC Architect Modules on page 2-6

Install Oracle 8.0.6 Utilities
BSC Architect requires the Oracle 8.0.6 Utilities.  You will install these utilities as shown in 
the installation steps.

1. Download the Oracle Balanced Scorecard 8.0.6 client for the Architect patch 1992496 
from MetaLink and copy to a temporary directory on your desktop.  Ensure that you 
choose the patch file for your platform. 

2. Unzip the patch.

3. Run the setup.exe program.  To ensure that you do not overwrite other utilities from a 
previous installation, we recommend that you create a different home for the Oracle 
8.0.6 utilities.  Remember also that this home must be the same home directory in which 
you will install BSC Architect.
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Figure 2–1 Oracle 8.0.6 Setup, Installation Settings Window

4. Select the Oracle8 client installation.  

Figure 2–2 Oracle 8.0.6 Setup, Installation Options Window

5. Select the user. 

n If you are using Windows XP, select Application User. 

n If you are using Windows NT or other version, select Administrator. 
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Figure 2–3 Oracle 8.0.6 Setup, Client Configuration Window

6. You will receive a notice that required support files will be installed to the ORACLE_
HOME\bin directory.

Figure 2–4 Oracle 8.0.6 Setup, RSF Confirmation Window

7. Choose where you want to access the Oracle documentation:  from a CD-ROM or from 
your local drive.  If you install files locally, they require 80.3 MB of disk space.

Note: Ensure that your primary home is the Oracle 8.0.6 home.  If you 
have a Home Selector utility under Oracle Installation Products, use this 
utility to configure your primary home.
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Figure 2–5 Oracle 8.0.6 Setup, Documentation Installation Options

8. You should receive a confirmation if installation was successful. 

Figure 2–6 Oracle 8.0.6 Setup, Installation Confirmation Window

9. Reboot your machine for all changes to take effect.

Figure 2–7 Oracle 8.0.6 Setup, Reboot Window
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Install Oracle 9i Release 2 (Windows XP Users Only)
Install Oracle 9i Release 2 if you are using Windows XP only.

1. Install Oracle 8.0.6 Client. See: Install Oracle 8.0.6 Utilities on page 2-2.

2. If you have a previous version of Oracle Client or a personal version (other than Oracle 
8.0.6) , then un-install Oracle Objects from OLE from existing Oracle Homes. 

3. Install Oracle 9i Client Release 2 (9.2.0.1.0) for Windows. Ensure that you select the 
Administrator Installation. 

Refer to Readme and Installation Guide for installation instructions. 

Install Note: Oracle Object for OLE, being a COM component, is not a MULTIPLE 
ORACLE HOME product. Be sure to install it under the Oracle 9i client home. You can 
verify that the "oo4o" directory has been created under the Oracle 9i client home. 

4. Install the BSC Architect under the 9i client Oracle Home.

5. Once these steps are complete, go to Post-Installation Tasks on page 2-13.

Post installation Note for Windows XP users:

n Be sure to define the TNS service name under both 9i and 8.0.6 Homes.

n Create the ODBC Data Source in 9i only.

n Set up the database using BSC Setup as described in Administration Guide BSC 
Setup Chapter.

Install BSC Architect Modules
Use the Oracle Universal Installer to install the modules for BSC Architect, which contains 
the BSC design and administration tools. 

1. Download the Balanced Scorecard Architect patch 3243701 from MetaLink and copy to 
a temporary directory on your desktop. 

2. Unzip the patch.

3. Launch the BSC Architect installation program, setup.exe, from the 
client\win32\OBSC_Architect\install\win32 directory on the patch in the previous step.

Note: You must uninstall the Oracle Objects, so Oracle 9i can install the 
newest components.
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Figure 2–8 Oracle Universal Installer, Welcome Window

4. Choose Deinstall Products, then go to your Oracle 8.0.6 Utilities path to check whether 
you have previous releases of BSC Architect installed in your Oracle 8.0.6 home.  If 
you do, select the BSC check box and choose to remove the BSC components. 
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Figure 2–9 Inventory Window

After removing any existing Balanced Scorecard components (or if there were none), 
close the Deinstall window, then choose Next to start the BSC Architect installation.
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Figure 2–10 Oracle Universal Installer, File Locations Window

5. The File Locations window displays the products.jar directory path.  If you do not see 
products.jar, choose the Browse button to locate the file on the Balanced Scorecard CD.  
Otherwise, do not change the default path.

Choose a destination Oracle Home for your Balanced Scorecard installation.  This must 
be the same Oracle 8.0.6 home you created previously.  If you have more than two 
homes, change the Name and Path to that of your Oracle 8.0.6 home.

6. Choose Next.

Note: If you are Windows XP user and have installed Oracle 9i, you 
must select the Oracle 9i home instaed of the Oracle 8.0.6 home.
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Figure 2–11 Oracle Universal Installer, Installation Types Window

7. If you have not previously installed the Oracle 8.0.6 utilities you will receive an error 
message. Otherwise, you can proceed selecting the options to install. Select the first 
option to install all Balanced Scorecard modules. This should be the selection if you are 
installing for the first time. Custom can be selected to install or update particular 
components of the application. Click Next to continue. A summary window appears.  

8. In the summary screen, ensure that you have the correct selections.  If you need to 
change a selection, you can click Previous and revise your selections.  When you are 
finished, choose Install to launch the install process.



BSC Architect Modules Installation

Installing Balanced Scorecard 2-11

Figure 2–12 Oracle Universal Installer Summary Window

9. The install process begins.  The process creates the installactions.log file in the \logs 
directory noted on the Install Process screen.  This file logs any errors that occurred 
during installation.  It is recommended that you check the error log after installation and 
reinstall any components that failed.
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Figure 2–13 Oracle Universal Installer, Install Process Window

10. If the process was successful, you should receive a confirmation message shown in 
Figure 2–14.
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Figure 2–14 End of Installation Window

11. After you finish installing BSC Architect, you must reboot your computer.

Post-Installation Tasks
Once you have completed installing the design and administration tools, you must complete 
these post-installation tasks:

n Define the Service Name

n Define the Data Source Name

n Configure the System
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Step 1  Define the Service Name in 8.0.6
Before you connect to Balanced Scorecard, you must define a service name for the database 
you are connecting to.  The service name is a logical name stored locally that refers to the 
database.  To define the service name, follow these steps.

1. Go to Start > Programs > Oracle 8.0.6 Home > Oracle Net8 Easy Config

2. At the first prompt, type in a New Service Name.  If you wish, you can modify an 
existing Service Name by clicking Modify and choosing a name from the list of 
Existing Net Service Names.  When you are finished, click Next.

Note: Before beginning these steps, check your Oracle Installation 
Products - Home Selector to ensure that your Oracle Primary home is 
8.0.6. 

If you are working with multiple language settings (MLS), please make 
sure that NLS_LANG environment variable is set correctly in your 
Control Panel before you run your BSC Architect or BSC Manager.

To set the environment variable, go to the Control Panel, choose System, 
and then choose teh Environment tab. Please refer to the Oracle 
Applications Documentation - National Language Support Guide, "Setting 
Up an NLS Environment, Choosing a Local with NLS_LANG" for the 
proper format and the list of available values.

For example, to set a Korean locale in a Korean OS with KSC5601 16-bit 
Korean encoding, the format is NLS_LANG=Korean_Korea16KSC5601.

Note: Make a note of this new service name since you will need it later 
during Balanced Scorecard Installation. 
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Figure 2–15 Net8 Easy Config Welcome Window

3. At the next prompt select TCP/IP (Internet Protocol), then choose Next.  If you are 
configuring a personal database, you may choose a local connection.

Note: Windows XP users with Oracle 9i  installed, need to define the 
service name in Oracle 9i. Refer to "Define Service Name in 9i". and be 
sure to install it under the Oracle 9i client home.

n Be sure to define the TNS service name under both 9i and 8.0.6 
Homes.

n Create the ODBC Data Source in 9i only.
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Figure 2–16 Net8 Easy Config Network Protocol Selection

Figure 2–17 Net8 Easy Config Network Protocol Selection

4. You are prompted for a Database SID, which is the Oracle database instance to which 
you want to connect.  This value is the same as your global database name.  When you 
have entered a name, choose Next to continue.
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Figure 2–18 Net8 Easy Config SID Selection

5. The next screen gives you the option to test the database.  Enter a valid Username and 
Password, then choose the Test button.  If you receive an error message the database 
username or password are incorrect, or your database is not properly configured.  
Change your login information and try again.

If your connection is not successful, you may want to check the following:

n Port number may not be the one used by the listener on the server.

n ORACLE_SID may not be correct.

n Userid or password may not be correct.

n Listener on the server may not be up.

n Server name may not be correct.
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Figure 2–19 Net8 Easy Config Connection Test

6. Restart your computer to makes these changes effective.

Congratulations, you have defined a Service Name! Make sure you remember the name of 
your Service Name. If your forget the Service name, you can go back into Net8 Easy Config 
and choose the Modify radio button. Then scroll down until you find your Service Name. 
You may also click the Next button to see additional details about each Service Name. 

Step 2  Define Service Name in 9i
Only perform this step if you are a Windows XP user. 

1. Go to Start > Programs > Oracle 9i Home > Configuration and Migration Tools > Net 
Configuration Assistant.

2. Select Add.

3. Select Oracle 8i or latest verion.

4. Enter the Service Name.

5. Select the type of protocol. Example: TCPIP.

6. Enter the Host Name and Port.
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7. Enter the Service Name.  

Step 3  Define the Data Source Name
The Data Source Name is an ODBC Driver that connects the service name for your database 
to a computer host name.  To define a data source name, follow these steps.

1. Configure your Data source name (DSN) using the appropriate service name.  From 
Windows NT, go to Start > Settings > Control Panel > ODBC.  The following screen 
appears:

Figure 2–20 ODBC Data Source Administrator Window

2. Choose the Add button to create a new Oracle ODBC driver.  On the Create New Data 
Source window, select the entry for Oracle ODBC Driver, version 8.00.06.00, then 
choose Finish.

Note: If you are Windows XP user and have installed Oracle 9i, you 
must choose the  Oracle ODBC Driver 9i version.
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Figure 2–21 Create New Data Source Window

3. Enter your Service Name (for example, bsc115) in the Data Source Name and Service 
Name fields.  If you wish, you can enter a description in the Description field.  Press 
OK.  Your data source name is configured. 

Figure 2–22 Oracle8 ODBC Driver Setup Window
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Step 4  Configure the System
After you’ve created the DSN and service name, use the BSC Setup Wizard to register your 
new Balanced Scorecard system.  For more details about the Setup Wizard, see the Setup 
chapter in Oracle Balanced Scorecard Administration Guide, Release 4.8.

1. Log into Balanced Scorecard Setup, use:

User:  APPLSYSPUB

Password:  PUB

2. Navigate to the BSC Setup Wizard, then choose the System Configuration tab. For more 
information on the Setup Wizard, see the Oracle Balanced Scorecard Administration 
Guide.

3. To register the Oracle Applications database in Balanced Scorecard, choose the Apps 
checkbox.  The information displayed on the System Configuration tab will change, as 
shown in the figure below.  Provide the database information requested in the Choose 
Registered System Name region of the window, then choose OK.

Figure 2–23 BSC Setup, System Configuration Window
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Check the UTL_FILE_DIR Parameter

If you need to install Enterprise databases for migration purposes, check the settings for 
UTL_FILE_DIR parameter to make sure it points to the directory where you will load 
Balanced Scorecard tables.  Locate the init<sid>.ora file in the <Oracle 
Home>\DATABASE directory.  Within init<sid>.ora, check the settings for UTL_FILE_
DIR and set as given below. If the above parameter is not set in the init<sid>.ora  file, check 
in the file specified with the IFILE parameter. Locate the IFILE variable and note the 
filename referenced in that variable. Open the referenced file and add the parameter:

UTL_FILE_DIR=<directory>

For example:

UTL_FILE_DIR=c:\temp

Step 5  Log into BSC Architect
To log into BSC Architect in Oracle Applications, you will use the 
SYSADMIN/SYSADMIN login. 

Troubleshooting
If you experience trouble with your Balanced Scorecard system, review some of the 
following troubleshooting tips.

BSC Architect Installation  

n Reboot your machine after installing or de-installing components.

n You may have some .dlls or .ocx files previously installed or in memory running at the 
moment of installation.  However, usually the installer will not overwrite these files and 
you can click Ignore and continue the process.

n If you receive an I/O Error, please go to the Windows NT Task Manager and end the 
process jrew.exe in case this file is active.

n Be sure you review your Oracle Home selector and you have the primary home defined 
for Oracle 8.0.6 Utilities and Balanced Scorecard. Otherwise you will not be able to 
connect to the database.

Note: Be aware that only the System Administrator has the right to login 
to the Architect, Manager and Setup Wizard.



Troubleshooting

Installing Balanced Scorecard 2-23

n Note that the file installAction.log is saved in a path during installation. Please note the 
directory to check in case you have errors during the process. Please don't delete the file 
since this log is used for future installations.

n Be sure your data source name (DSN) is created with Balanced Scorecard driver version 
8.00.6. If the Oracle driver is not 8.00.6, you may have to uninstall and reinstall the 
driver to get the correct version. To review your data source, go to Start > Programs > 
<New Oracle Home> > Network Administration > Microsoft ODBC Network 
Administrator.  You can test your connection by logging into <New Oracle Home> > 
Applications Development > SQL with username of ’system’ and password of 
’manager’.  If you have not created a DSN, follow the instructions below.

n If you encounter any font issues in the BSC Architect after installation, such as the 
substitution of ’???’ for characters, you must manually install the font.  You can do this 
by editing the obscfont.dat file located in the <Oracle Home>\OBSC directory.  For 
example:

FONT_NAME = MS Sans Serif
FONT_SIZE = 8

If the file does not exist you must create it.

n When you use a multi-byte character language please check if the "obscfont" accepts 
your language characters. You may need to change the "obscfont" to another font that 
supports your language characters.

n If you get the message, ’Setup wizard couldn’t find the bin utilities’ check to see that 
the file obscinit.dat in your <Oracle home>\OBSC directory points at your <Oracle 
home>\bin directory.  For example:

n ORACLE_UTILITIES_DIR = d:\ora806\bin if ora806 is your primary home.

n If you get one of the following error messages:

n ORA-12545 Connect failed because target or host is not found

n ORA-12203 TNS unable to connect to destination or TNS No Listener

check the following:

n Make sure the DB Listener is running.  Contact your database administrator for 
more information.

n Verify that the Port ID and Database SID are correct for the service name you 
created using Net Easy Config.

Multilanguage Synchronization Tables  
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If you already use a second language with Balanced Scorecard or if you added a second 
language before upgrading to 4.8.2, you must run the following script after installing 
Balanced Scorecard 4.8.2 in order to synchronize the MLS tables:

$BSC_TOP/admin/sql/BSCNLINS.sql

You don't need to run this script if the second language is added after installing Balanced 
Scorecard version 4.8.2.
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Data Source Name

The Data Source Name will be used by the BSC Setup Wizard to create new systems or 
modify systems in the database. (Since the Data Source Name is always linked to a Service 
Name, the application always knows what database to use by referring to the Data Source 
Name). 

Service Name

The Service Name is a user-defined logical name that contains information about the exact 
name and server location of the Oracle database. This name is defined on the user’s PC, and 
will be used by the Oracle Balanced Scorecard to find the database and connect to it. 

Registered System Name

The name by which a particular balanced scorecard system (that exists on a database 
somewhere) is registered on your computer. 



Glossary-2



Index-1

Index
A
architecture options, 1-2

B
BSC Architect platform requirements, 1-4
BSC components, 1-2

D
data source name, Glossary-1
data source name, defining, 2-19
design and administration tools, 1-3
design and administration tools, installation tasks, 2-2
design and administration tools, postinstallation 

tasks, 2-13
design and administration tools, preinstallation 

tasks, 2-1

I
installing OBSC, 2-1

O
OBSC Architect modules, 1-3
OBSC Architect, installation steps, 2-6
OBSC Architect, installation tasks, 2-2
OBSC Architect, postinstallation tasks, 2-13
OBSC Architect, preinstallation tasks, 2-1
Oracle 8.0.6 client, installation steps, 2-2
overview, 1-1
overview, BSC application, 1-1

R
registered system name, Glossary-1

S
service name, Glossary-1
service name, defining, 2-14
system requirements, 1-4



Index-2


	Contents
	Send Us Your Comments
	Preface
	Accessibility of Code Examples in Documentation
	Accessibility of Links to External Web Sites in Documentation

	1 Introduction
	Overview
	System Architecture
	Three Tier Architecture for BSC Viewer
	Architecture for BSC Architecture Modules

	System Requirements
	BSC Architect Platform Requirements


	2 Installing Balanced Scorecard
	BSC Architect Modules Installation
	Prerequisites
	Installing BSC Architect Modules
	Install Oracle 8.0.6 Utilities
	Install Oracle 9i Release 2 (Windows XP Users Only)
	Install BSC Architect Modules

	Post-Installation Tasks

	Troubleshooting

	Glossary
	Index

